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About the Calendar Module
The e-Builder Calendar module is a project-specific calendar that brings all project participants, both internally 
and externally together for scheduling in one place. The e-Builder calendar integrates with Microsoft Outlook, 
and automatically syncs your e-Builder calendar events to your Outlook Calendar. If your project team consists 
of multiple companies using multiple calendars, e-Builder manages events by allowing you to invite your e-
Builder users and contacts as well as external users and then tracking attendance, meeting minutes, and pro-
gress on resulting action items.

Need to see the big picture? With the e-Builder calendar module you can see your events, invited events, and 
public events across all of your projects all in one view. Better yet, at a glance you can see your agenda for the 
next 30 days. Set up reoccurring weekly status meetings, create automatic reminder notifications, update the 
attendance, and instantly bring up anything on your calendar with the built-in search tool.

Key Concepts of the Calendar Module

e-Builder is an integrated project management and collaboration system for the construction industry. The e-
Builder calendar module provides a place to store important meeting dates in one location for everyone to 
access. Before you start using the e-Builder calendar module you should familiarize yourself with some key 
concepts used throughout this section.

Project

Most everything in e-Builder takes place within the context of a project. Projects in e-Builder refer to the vari-
ous projects that you are participating in. Each real world project is associated with a project in e-Builder. If you 
are working on the real world project, then you can be added as a member of the project in e-Builder. Your Pro-
ject Administrator or Manager will be able to add you as a member of a project in e-Builder.

Event

The e-Builder calendar module is a system for naming periods of time, known as calendar events. Each event 
created in e-Builder is a meeting, or gathering of individuals who meet at a pre-arranged place and time in 
order to discuss or engage in business matters. Invitations can be sent out to e-Builder users, contacts, and 
non e-Builder users.

Contact

In order to invite a contact to a calendar event you must have the person created as a contact first. Each con-
tact invited must have an email address. It is important to mention that a contact is different than a standard e-
Builder user. An e-Builder user is someone that has been added to the e-Builder account as a participant to a 
set of your projects. An e-Builder contact is a record of contact information (such as phone number, fax, email 
address, street address, etc.) associated with an e-Builder Company. These contacts do not have access to all 
of your e-Builder project information; only the calendar event that the contact is invited to.

Access the Calendar Module
Note: Upcoming calendar events display in the Calendar section located on the right side of the Home page.
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There are two methods of accessing the Calendar module. The first is from the Top Navigation Tabs, which 
should be used if you are not already in a project. However, if you are in another module within the same pro-
ject, the best way to access the Calendar module is from the project menu - this will help you avoid reselecting 
your project.

From the Top Navigation Tabs
 1. Click the Calendar tab located at the top of the page.
 2. Click the All Projects drop-down menu and select your project. The Project Calendar page is dis-

played.

From the Project Menu

If you are already within a project, you can access the Calendar module via the Project Menu located in the left 
navigation bar.

 l Click the Project Calendar link. The Project Calendar page is displayed.

Access Event Details Page
To access the Event Details page

 1. Go to the Calendar module.
For more information see Access the Calendar module.
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 2. Click the title of the event to open the Event Details page.
 3. If there are multiple meetings available, click the Meeting Number drop-down arrow to make the appro-

priate selection.

Calendar Views
Calendar views offer a quick and easy way to see customized views of the calendar with just one click. By 
default, an All Events calendar view and a My Event calendar view is available. The All Event calendar view 
allows you to add account calendar events. You can also customize your view with a number of event and pro-
ject details such as city, project name and project status, just to name a few.

Create My Events Calendar View

The My Events calendar view gives you quick and easy access to just those meeting that you are a par-
ticipant of.

To create a My Event calendar view

 1. Click the Calendar tab located on the Top Navigation Tabs.
 2. Click the Add View link. The Add View page is displayed.
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 3. Enter the name of the view Name field.
 4. Click the My Events radio button.
 5. Click Save.

Create All Events Calendar View

The All Events calendar view is a default option. This view allows you to see all events for every project. 
From this view you can also add account level calendar events.

To create an All Events calendar view

 1. Click the Calendar tab located on the Top Navigation Tabs.
 2. Click the Add View link. The Add View page is displayed.

 3. Enter the name of the view Name field.
 4. Click the All Events radio button.
 5. Click Save.

Create a Custom Calendar View

The custom calendar view option is very flexible. You can create a number of custom calendar views to suit 
your needs. This option allows you to customize your view with a number of event and project details. Fil-
ters are available to help you create very specific views such as those for projects of a particular status or 
type, such as all OAC meetings for projects currently in Design, for example.

To create a custom calendar view

 1. Click the Calendar tab located on the Top Navigation Tabs.
 2. Click the Add View link. The Add View page is displayed.

 3. Enter the name of the view the Name field.
 4. To create your custom view based on all events, click the All Events radio button. To create your 

custom view based only on the events you are a participant of, click the My Events radio button.
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 5. Click the Search Rule #1 drop-down arrow and select an event or project detail by which to choose 
the first criteria of this custom view.

 6. Click the second column drop-down arrow to select a qualifier.

 7. In the third column, enter the qualifying value. If available, you can also click the Lookup button to 
select from a list of options.

 8. Click Save.

Add Events
Events can be added to the general account calendar for all account users to see and access, but they can 
also be added to the project calendar. In addition, you have the capability to copy events between the general 
account calendar, project calendars and vice versa, as long as meeting minutes have not yet been entered for 
the event. Below is a list of procedures for adding calendar events and moving events between the account 
and project calendars.

 l Add Account Calendar Events
 l Add Project Calendar Events
 l Copy Events Between Calendars

Add Account Calendar Events
Account calendar events are available for everyone on the account to see. To add a project-specific calendar 
event, see Add Project Events.

If an All Calendar Events view has been created, you will be able to see all events when accessing the main 
Calendar page. From this Calendar view you are able to add events on an account level, so that everyone on 
the account is able to see it.

To add an account calendar event

 1. Click the Calendar tab located on the Top Navigation Tabs.
 2. Click the View drop-down arrow and select All Calendar Events.

For more information on creating calendar views, see Calendar Views.

 3. Click Add Event.
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 4. Enter the subject of the meeting in the Subject field.
 5. In the Date and Time fields, click the calendar icons to select a starting and ending date for the meet-

ing.
 6. In the Date and Time fields, click the time drop-down arrows to select a starting and ending event time.
 7. For a single meeting, in the Repeats section, select the One Time radio button.

—Or—
For recurring meetings, in the Repeats section, select the Daily, Weekly, or Monthly radio button. For 
more information on the fields of the Add Event page, see Add Event Page Overview.

 8. Click Save.

Add Project Events

To add an event to the project calendar

 1. Go to the Calendar module.
For more information, see Access the Calendar Module.

 2. Click Add Event.
 3. Enter the subject of the meeting in the Subject field.
 4. In the Date and Time fields, click the calendar icons to select a starting and ending date for the meet-

ing.
 5. In the Date and Time fields, click the time drop-down arrows to select a starting and ending event time.
 6. For a single meeting, in the Repeats section, select the One Time radio button.

—Or—
For recurring meetings, in the Repeats section, select the Daily, Weekly, or Monthly radio button.

Note: For more information on the fields of the Add Event page, see Add Event Page Overview.

 7. Click Save.

Copy Events Between Calendars
You have the ability to copy events between the general account calendar, project calendars and vice versa, 
as long as meeting minutes have not yet been entered for the event. This functionality can be useful if the 
same meeting and meeting details are required across projects or if a meeting was created on the wrong cal-
endar by accident. The ability to copy events saves you the time of imputing duplicate details.

This action can be done by the project organizer or administrator. Once the event is copied over, you can then 
add meeting minutes. Once meeting minutes have been added, the event CAN NOT be copied between cal-
endars.

To copy events between calendars

 1. Click the Calendar tab located on the Top Navigation Tabs.
 2. To copy an account calendar event, click the name of the event located on the calendar.

—Or—
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To copy a project specific event, click the Go to Project Calendar for drop-down arrow to select the 
project, and then click the name of the event located on the calendar.

 3. Click Copy Event.
The Copy Event To submenu displays.

 4. Select either the General Calendar or Project radio button to select the calendar to copy the event to.
If you selected Project, click the drop-down arrow to select the project.

 5. Click Copy.
The Copy Event Event Overview page is displayed for you to update meeting details if necessary.

 6. Click Save.
The Add a Note page is displayed.

 7. Optional: You can enter a note.
 8. Click Continue.

Add Attendees
For all meetings that have occurred in the past, you can add attendees to include individuals who may have 
attended unexpectedly. This way, they too can be kept abreast of the meeting minutes and action item 
statuses.

To add attendees

 1. Go to the Event Details page.
For more information, see Access Event Details Page.

 2. Click the Attendees tab.
 3. Click Add Attendee.

The Add Attendees dialog box displays.
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 4. Click Lookup to search for and add attendees.
The Lookup dialog box displays.

Note: You can also enter user's email addresses in this field, one per line.

 5. Filter the contacts you're looking for by entering requested information.

Note: To see all users and contacts, click Filter without entering any information.

 6. Select the check box next to the user(s) you want to add.
 7. Click Insert Selected.

The Add Attendees dialog box displays.

 8. Click Save.

Update Attendance
Updating attendance allows you to record whether or not an attendee was present at the meeting. If an 
attendee was not on the original attendee list, they must first be added, and then their attendance can be 
updated. For more information, see Add Attendees.

To update attendance

 1. Go to the Event Details page.
For more information, see Access Event Details Page.

 2. Click the Attendees tab.
 3. Click Update Attendance.

The Update Attendance page displays.

 4. Select the check box in the Attended column to record attendance.
Leave the check box empty to indicate attendee absence.

 5. Click Save.

Add Notes
The Notes tab allows users to quickly add notes of importance. Notes allow all team members who have the 
permission to see the communication. For each note entered, the first and last name and company name of 
the user will be displayed along with the date. Contained within the tab, in parenthesis, Trimble Unity Construct 
displays the total number of notes created.

To add notes

 1. On the Notes tab, click Add.
The Add Note page is displayed.

 2. Enter the note in the Note field.
 3. If the Private check box is available, you can select it to hide your note from other team members.
 4. Click Save.
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View Attached Documents
From the Documents tab you can view, download and redline documents that have been attached to the event 
during the event creation process.

To view, download or redline documents

 1. Go to the Event Details page.
For more information, see Access Event Details Page.

 2. Click the Documents tab.
 3. Click:

 a. View
 b. Download
 c. Redline

Attendee Invitation
The invited parties to a calendar event receive an e-mail with a meeting request and can indicate whether or 
not they intend to attend the event. After they make their selection their status is automatically updated in e-
Builder.The e-mail will indicate if they are required or optional. They can then click the Yes, No, or Maybe links. 
(They do not have to use Outlook to be able to push the links at the bottom; they are not specific to Outlook.)
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When the user selects a response (Yes, No, Maybe), a new window opens allowing them to review their 
response. The user can update their response by clicking on the Change Response link.

After clicking on the Response link users are able to make their new selection, and then click Save Changes 
to update their status.
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Note: There is a limit of 500 rows (representing attendees invited), for system speed and efficiency.

Meeting Minutes
The Meeting Minutes component allows the minute taker to record discussion topics within e-Builder. The 
review and approval mechanism ensures that all participants agree with notes and action items before minutes 
are published. Optionally, you can assign action items using an assigned form type. Action items are updated 
in real time, so all participants are aware of item status before the next meeting. The Meeting Minutes com-
ponent also gives you the ability to carry open items forward from previous meetings, allowing you to keep 
track of your progress. The diagram below illustrates how meeting minutes can be used.
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Add Meeting Minutes

To add meeting minutes

 1. Go to the Event Details page.
For more information, see Access Event Details Page. The Meeting Items tab is automatically selected.

 2. Click the Meeting Type drop-down arrow and select the meeting type.

Note: The Meeting Number field automatically defaults to the next available number for the selected 
meeting type, but you can also enter a meeting number.

 3. Click Save.
 4. Click the Topic drop-down arrow to select a topic or enter free form text in this field.
 5. In the Discussion area, enter the topic discussion.
 6. Click the Add link located left of the Topic column.

Carry Open Items Forward 
Carrying open items into the subsequent meeting minutes allows you to keep track of action items. Please be 
aware that you can only carry items forward for the same meeting type. Additionally, the outstanding minutes 
must have already been published and is currently in Open status.

To carry open items forward

 1. Go to the Event Details page.
For more information, see Access Event Details Page.

 2. Click Add Open Items.
 3. Select the check box next to the item(s) you want to carry forward.
 4. Click Carry Forward.

Add Action Items
Action items can be added to meeting minutes for transparency into required actions and responsible parties. 
Action items are updated in real time. Once the form is filled out and posted by the assigned individual, the 
status will automatically update in the meeting minutes for all event attendees to see.
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The Trimble Unity Construct Administrator can specify a form type to be used as an action item whenever 
needed. This type of form is considered an existing action item. The minute taker can however choose a new 
action item/ form to add as well. The following procedures are included below:

 l Add an Existing Action Item
 l Add a New Action Item

Note: Action items can only be added to the most recent meeting. Otherwise, the option is not available.

To add an existing action item

 1. Go to the Event Details page.
For more information, see Access Event Details Page.

 2. Click the Existing link in the Action Req. column.
The Attach Forms from [Account Name] page is displayed.

 3. Click the Type of Form drop-down arrow and select a form type.
 4. Select the check box next to the form(s) you want to add.
 5. Click Attach.

To add a new action item

 1. Go to the Event Details page.
For more information, see Access Event Details Page.

 2. Click the New link in the Action Req. column.
The Fill Out Form page is displayed.

 3. Click the Type of Form drop-down arrow and select a form type.
 4. Enter all required fields.
 5. Click Post Form.

Publish Meeting Minutes
Publishing meeting minutes makes them available to all attendees when they access the Calendar module. 
You will no longer be able to edit the meeting minutes once they are published, but you will still be able to 
modify meeting status.

To publish meeting minutes

 1. Go to the Event Details page.
For more information, see Access Event Details Page.

 2. Click Publish.
You are prompted for confirmation.

 3. Click OK.
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Send Meeting Minutes
Meeting minutes are typically sent to all attendees and stakeholders at the close of each meeting. Anyone with 
the ability to manage meeting minutes, based on the setting in the event details, is able to send the minutes. 
Before finalizing your meeting minutes, you may have to carry open items forward, in order to keep track of 
action items. Additionally, you might consider using a mail merge template to help include system data without 
any manual effort. A default mail merge template is available and selected by default, but it can be customized; 
see Add New Calendar Templates for more information.

Tip
In the event an internet connection is unavailable, you can always copy and paste into the Trimble Unity 
Construct text editor from a text file, such as Microsoft® Word or OneNote®.

To send meeting minutes via email

 1. Go to the Event Details page.
For Instructions, see Access Event Details Page.

Note: You can optionally carry open items forward for a previous meeting.

 2. Click Send Meeting Minutes.
The Send Meeting Minutes window appears.

 3. Complete all required fields.

Tip
Trimble Unity Construct users and contacts will auto-fill as you begin to type their name or email 
address in the To field.

 4. Click Send.

Related Topics:
 l Add/Edit Event Page Overview
 l Carry Open Items Forward
 l Add New Calendar Templates
 l Customize Calendar Template with Field Mappings

Attach Documents
Documents can only be added to an existing action item. The paper clip icon that allows you to add a doc-
ument does not appear until the action item is added. For more information, see Add Action Items.

Tip
In IE10, Firefox, Chrome, and Safari browsers, you can simply drag and drop documents from your local dir-
ectory onto the Attached Documents tab. This can be done to attach documents throughout e-Builder Enter-
prise.

To attach documents to an action item

 1. Go to the Event Details page.
For more information, see Access Event Details Page.

add_new_calendar_templates.htm
add_new_calendar_templates.htm
customize_calendar_template_wi.htm
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 2. Click the paper clip icon.
The Attach Documents dialog box displays.

 3. Click Add.
The Attach Documents dialog box displays.

 4. In the Select Attachment Method section, select your method of attachment.
 5. Click Browse For Files...
 6. Search for and select the file you want to attach.

You are returned to the Attach Documents dialog box.

 7. If you are attaching files from e-Builder, go to step 9.
—Or—
If you are uploading files from your computer, in the Select an e-Builder Destination folder, click 
Browse.

 8. Search for and select the e-Builder destination folder.
 9. Click Attach Selected.

Project Calendar Page Overview
Fields and Buttons

The fields and buttons located on this page are:
 l Calendar For [Project Name]: Click this drop-down arrow to select a different project calendar to view.
 l Month: Click this tab to view the entire month.
 l Week: Click this tab to view the entire week.
 l Work Week: Click this tab to view the entire work week. The days that comprise the work week are 

assigned in the Administration Tools section.
 l Day: Click this tab to view the current day.
 l Upcoming Events: Click this tab to view all upcoming events for the next 30 days.
 l Today: Click this link to view the present day.
 l Print: Click this link to print the calendar in the selected view.
 l Add Event: Click this button to add an event to the calendar.
 l Left Arrows: Click these arrows to view the previous month.
 l Right Arrows: Click these arrows to view the following month.

Add/ Edit Event Page 
The Add Event page is displayed when you click the Add Event button located on the Project Calendar page. 

Fields and Buttons

The fields and buttons located on this page are:
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 l Project Calendar: By default this field displays the event type you've selected (account calendar event 
or project calendar event). Click the drop-down arrow to switch between calendar types or projects.

 l Subject: Enter the subject of the meeting in this field.
 l Meeting Type: Click the drop-down arrow to select a meeting type from the list. Meeting types can be 

edited in the Administration Tools section by your Trimble Unity Construct administrator.
 l All Day Event?: Click this check box to make this an all day event. This will effectively remove the time 

drop-down arrows from the Date and Time field below it.
 l Date and Time: Click the calendar icons to select a start and ending date for the event. Click the time 

drop-down arrows to select a starting and ending time.
 l Repeats: 

 o One Time Select this radio button if you are scheduling a onetime event.
 o Daily  Select this radio button if the event occurs daily.
 o Weekly Select this button if the event occurs on a weekly basis.
 o Monthly Select this button if the event occurs monthly.

 l Location: Click the drop-down arrow to select a meeting location. The adjacent field will automatically 
populate with the description if it was added in the location setup.

 l Agenda / Description: Enter the agenda or an event description.
 l Reminder: Click the drop-down arrow to select a reminder time.
 l Privacy: Select Private to grant only meeting attendees to ability to see this event. Select Public to 

make the event viewable by everyone on the project, even if not invited to the event.
 l Required Attendees: Enter the email address of all required attendees. Click Lookup to search for 

users and contacts that are already saved in Trimble Unity Construct.
 l Optional Attendees: Enter the email address of all optional attendees. Click Lookup to search for 

users and contacts that are already saved in Trimble Unity Construct.
 l Attendees Who Can Manage Meeting Minutes: Enter the email address of attendees that are able to 

manage meeting minutes.
 l Priority: Click this drop-down arrow to set an event priority. Select from High, Normal, and Low.
 l Custom Fields Tab: If applicable, click the Custom Fields tab to complete all custom fields.
 l Documents Tab: Click the Documents tab to attach documents to the event. Event participants have 

access to attached documents and are able to view, download and redline documents. From here you 
can also remove attached documents.

 l Forms Tab: Click the Forms tab to attach forms for participants to complete or view. From here you can 
also remove attached forms.

 l Processes Tab: Click the Processes tab to attach processes to the event as a form of reference. From 
here you can also remove attached processes.

Event Details Page 
The Events Details page allows you to view and edit event details. From the Meeting Items tab you can also 
take a number of actions regarding meeting minutes, such as the following:
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 l Send Meeting Minutes
 l Carry Open Items Forward

Fields and Buttons

The fields and buttons located on this page are:
 l Event Overview: This section provides an overview of the event. Click Edit Series or Edit Occur-

rence to modify any of the details listed. Click the Meeting Number drop-down arrow to jump to 
another meeting of the same meeting type.

 l Delete Occurrence: Click to delete the meeting occurrence.
 l Delete Series: Click to delete the meeting series.
 l Edit Occurrence: Click to modify the details of the occurrence.
 l Edit Series: Click to modify the details of the series.
 l Copy Event: Click to copy the event to on the same project calendar or to a different project cal-

endar. Copying events is a quick and easy way to add the same event to another project calendar, 
or create a similar event without having to input all event details.

 l Print: Click to print event details.
 l Meeting Numbers: The numbers in this column represent the meeting number and discussion item. 

The first number is the meeting number and second is the discussion number. When entering meet-
ing minutes, the meeting number defaults to the next available number in sequence, but users can 
also define meeting numbers when creating meeting minutes.

 l Show New Business: Select this check box to view all new business items. New business items 
are the topics and discussions of the most current meeting.

 l Show Old Business: Select this check box to view all old business items. Old business items are 
those topics and discussions of all previous meetings.

 l Topic: Click the Topic drop-down arrow to filter specific topics on the table.
 l Publish: Click this button to make meeting minutes available to all attendees when they access the 

Calendar module. You will no longer be able to edit the meeting minutes once they are published, 
but you will still be able to modify meeting status.

 l Send Meeting Minutes: Click this button to send meeting minutes via email. Minutes can be sent to 
attendees or anyone with a valid email address. For instructions, see Send Meeting Minutes. By 
default minutes are sent using the default template, but a customized template can be created by an 
account administrator. For more information, see:

 o Add/Delete Meeting Types
 o Add/Delete Meeting Topics

 l Sent Meeting Minutes: Click to track emails that have been sent from any given calendar event. 
Message history details include the sender, recipient, date and time stamp of sent messages, and 
the number of times a message has been opened. This button is only visible to administrators.

 l Add Open Items: Click this button to carry open items from a previous meeting to the current list of 
meeting minutes. For more information, see Carry Open Items Forward.

Related Topics:

adddelete_meeting_types.htm
adddelete_meeting_topics.htm
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 l Add Meeting Minutes
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